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INTRODUCTION
Welcome toMastercam Tool Manager Tutorial. This guide provides information about Mastercam's stand-alone Tool
Manager. Some of the information is step-by-step, and some is in a paragraph format. Both formats walk you
through how andwhen to use the stand-alone ToolManager.

Tutorial Goals

l Become familiar withMastercam’s stand-alone ToolManager

l Work with tool libraries (.TOOLDB) and their components

l Create and edit tools and holders inMastercam’s classic ToolManager

l Properly render imported tools

WARNING: Screen colors in the tutorial pictures were modified to enhance image quality; they may not
match your Mastercam settings or the tutorial results. These color differences do not affect the lesson or
your results.

Estimated time to complete this tutorial: 3 hours

General Tutorial Requirements
All Mastercam2019 tutorials have the following general requirements:

l Youmust be comfortable using the Windows® operating system.

l The tutorials cannot be used withMastercamDemo/Home Learning Edition. The Demo/HLE file format
(emcam) is different fromMastercam (mcam), and basicMastercam functions, such as file conversions and post-
ing, are unavailable.

l Each lesson in the tutorial builds on the mastery of the preceding lesson's skills. We recommend that you com-
plete them in order.

l Additional filesmay accompany a tutorial. Unless the tutorial provides specific instructions on where to place
these files, store them in a folder that can be accessed from the Mastercam2019 workstation, either with the
tutorial or in any location that you prefer.

l Youwill need an internet connection to view videos that are referenced in the tutorials. All videos can be
found on our YouTube channel:
www.youtube.com/user/MastercamTechDocs

l All Mastercam tutorials require you to configure Mastercam to work in a default Metric or Inch configuration.
The tutorial provides instructions for loading the appropriate configuration file.

Mastercam Tool Manager Tutorial—Introduction

http://www.youtube.com/user/MastercamTechDocs
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MASTERCAM'S TOOL MANAGER
Mastercam's stand-alone ToolManager provides an efficient and comprehensive way to manage tools and tool hold-
ing components, and to create tool assemblies to use inMastercam. Besides the tooling component support, Tool
Manager also integrates workmaterial and cut parameter data so that you can accommodate amanufacturer's cut-
ting recommendations or create your own cut parameter data and store it in the database.

Launch the stand-alone ToolManager separately fromMastercamby choosing Tool Manager from your Start
menu'sMastercam folder. Certain ToolManager functions are integrated into the Mastercam interface and are
launched fromwithinMastercamwhen you create new tools, holders, and assemblies. While you are in ToolMan-
ager, your data is automatically saved as you work.

Tool Manager Interface
This section contains brief descriptions of the stand-alone ToolManager interface.

1. Tabs: Tabs function somewhat like dialog boxes but look similar to toolbars. You cannot undock or dock a tab,
nor are they customizable.

2. Database Explorer: Use the Tool Manager Database Explorer to access content in tool database files
(TOOLDB). Right-click an item to expand or collapse it. To work with items in the database tree view (i.e., Cut-
ting Tools, Tool Assemblies, Holders, Materials, and Cut Parameters), double-click the item.

3. Assembly Tree: Use the Assembly Tree to create and edit assemblies in the open TOOLDB database. Tool
Assembliesmay contain one tool and one or more holder components. Use the Assembly Tree to navigate

Mastercam Tool Manager Tutorial—Mastercam's Tool Manager



the individual assembly items. If you double-click on Tool Assemblies in the Database Explorer or choose
Assembly on the Home tab, the Assembly Tree appears below the Database Explorer and the Assemblies
document appears in the documents area.

4. Document Datagrids: ToolManager uses "documents" to organize data such as tools, holders, and assem-
blies. The main workspace uses a tab-style interface to present these documents.

5. Graphics Window: The graphics window is part of a document, and displays what you have selected in the
document datagrid. For example, if you are working in the Assembly document, the graphics windowdisplays
the assembly you have selected in the datagrid.

6. Properties Grid: ToolManager Properties Grid displays properties for cutting tools, assemblies, holders,
extensions, materials, and cutting parameters. The properties displayed in the Properties Grid depend on
which document type you have open and which item you have selected in the document.

Stand-Alone vs. Classic Tool Managers
Although this tutorial focuses on the stand-alone ToolManager, Mastercamoffersmore than one ToolManager to
create, edit, andmanage your tools, tooling components, and tool libraries. Each ToolManager is accessed with dif-
ferent workflows and circumstances.

Stand-Alone Tool Manager

Mastercam Tool Manager Tutorial—Mastercam's Tool Manager
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The stand-alone ToolManager provides an interface to manage Mill and Router tools and tool holding components,
and to create tool assemblies to use inMastercam. Besides the tooling component support, ToolManager also integ-
rates workmaterial and cut parameter data so that you can accommodate amanufacturer’s cutting recom-
mendations. You can also create your own cut parameter data and store it in the database.

Classic Mill/Router Tool Manager

The classicMill/Router ToolManager allows you to view andmanage tool libraries, the tools in your part file, and tool
definitions. Use it to:

l View tools stored in a tool library, machine group, or both.

l Create new tools and store them in a tool library or machine group.

l Copy tools to/froma library to amachine group, or between different libraries or machine groups.

You access the Mill ToolManager by selecting Tool Manager on theMill or Router contextual tab.

Mastercam Tool Manager Tutorial—Mastercam's Tool Manager



Classic Lathe Tool Manager

The classic Lathe ToolManager has the same features as the classicMill/Router ToolManager.

You access the LatheToolManager by selecting Tool Manager on the Lathe Turning contextual tab.

Mastercam Tool Manager Tutorial—Mastercam's Tool Manager
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Working with the Stand-Alone Tool Manager
By using the stand-alone ToolManager instead of the ClassicMill or Lathe ToolManager, you can do the following:

l Work without Mastercam open: Although you need to have Mastercam installed to run the stand-alone
ToolManager, you do not have to have Mastercamopen. You don’t even need to have aMastercam License
plugged in. When you create, edit, and organize your tool libraries without runningMastercam, you increase
your computer’s performance while reserving that licensedMastercam seat for someone else.

l Search: You can search for tools, assemblies, and other components that match your search criteria. You can
save searches for future use as Favorites and you can view recent searches.

l Copy components or assemblies between libraries: You can copy tools, holders, and assemblies fromone
TOOLDB to another; open the different tool libraries in separate instances of ToolManager; and drag and
drop the tooling components or assemblies fromone ToolManager to the other.

l Create and edit assemblies: You can create and edit tooling assemblies. You can drag and drop assembly
components into the Assembly Tree, you can work directly in the ToolManager’s graphics window to edit
assemblies, and you can change the parameters for an assembly or for each of the assembly components in
the Properties Grid.

l Customizable workspace - The workspace of the stand-alone ToolManager allows you to undock the major
interface objects. This is useful if you work withmultiple monitors. It is also useful if you just want to repos-
ition or hide the interface windows to suit your preferences.

l Create and edit materials and cut parameters: ToolManager allows you to create and edit materials and
cut parameters. These settings are stored in the tool library and are easily accessed throughMastercam
when you create or edit a tool with the ToolWizard.

l Edit multiple components: You can select multiple document items, such asmultiple tools, and edit the
properties for all selected itemswith the Properties Grid.

In the next few chapters, you will learn about some of these concepts.

Recommended Workflow
The stand-alone ToolManager creates tool libraries (TOOLDB) that can be specific to a job and/or machine. You can
use these tool libraries as part of a job “kit” that resides on one machine, or that travels with the part.

The recommended workflow is to set up your tool libraries using the stand-alone ToolManager, and then use those
libraries inMastercam to apply to specific jobs, parts, andmachines.

After installingMastercam, youmust openMastercambefore opening the stand-alone ToolManager for the first
time, so that Mastercam can build support files. After openingMastercam, you can close it and successfully open the
stand-alone ToolManager. If you are working fromanewMastercam install and try to open the stand-alone Tool
Manager before opening and closingMastercamat least once, you will receive an error message prompting you to
openMastercam.

Mastercam Tool Manager Tutorial—Mastercam's Tool Manager
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CHAPTER 1
WORKING WITH TOOL LIBRARY FILES (.TOOLDB)

In this lesson, you learn to work with tool libraries.

Goals

l Switch to metric database output

l Create and edit tool libraries

l Use the stand-alone ToolManager's Search feature

Exercise 1: Creating Tool Libraries
In this exercise, you learn to create tool libraries by either copying an existing library or creating a TOOLDB from
scratch. Because you create metric tools and holders later in this guide, you set the default units to metric in this
exercise.

The default unit setting is read fromMastercam’s SystemConfiguration. ToolManager remains in the metric state
until youmanually change it back to inch, even if you use multiple sessions of ToolManager or turn off your com-
puter. All new tools and holders created in the stand-alone ToolManager or fromwithinMastercam, are created
usingmetric values until this option is changed back to inch units. You can have both inch andmetric tooling com-
ponents in the same library (.TOOLDB file).

Creating a Tool Library from an Existing Library

1. If the stand-alone ToolManager is not already running, open ToolManager from your Mastercam folder in
the Windows Start menu.

2. Open ToolManagerTutorial.tooldb, provided with this tutorial.

3. After the tool library loads, click the File tab (backstage view) and choose Options.

4. In the Application Options dialog box, choose the General page.

13



5. If it’s not already selected, set Default units toMetric.

6. ClickOK.

7. Select File, Save As.

8. Save the TOOLDB as ToolManagerTutorial_XXX.tooldb, replacing XXXwith your initials. You save the lib-
rary with a different file name so that you do not overwrite the file provided with this guide.

14
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Creating a New Tool Library from Scratch

1. Select File, New, Tool Database.

This opens a second instance of ToolManager.

2. In the Save As dialog box, enter a new file name of your choice and click Save.

Note: As you work in ToolManager, your changes are automatically saved to the database.

3. Close both sessions of ToolManager. Save any changes if prompted.

Exercise 2: Opening and Editing a Tool Library
In this exercise, you open an existing library in ToolManager and edit one or more of its components.

1. Open the stand-alone ToolManager.

2. Select Open and navigate to the ToolManagerTutorial_XXX.tooldb file you created in the previous exer-
cise.

3. Open each of the document types by double-clicking its library component in the Database Explorer.

Mastercam Tool Manager Tutorial—1: Working with Tool Library Files (.TOOLDB)



4. You should have the following documents open:

5. Review the buttons in the New Milling, New Accelerated Finishing, andNew Hole Making groups. Hover
your mouse over each icon to view a pop-up tooltip.

Below the following picture are brief descriptions of each item.

l Holder: Puts focus on the Holders document, and opens the Holder Wizard, where you can create a
newholder and add it to the library database.

l Assembly: Puts focus on the Assemblies document, and opens the Assembly Treewhere you can cre-
ate a new assembly.

l Material: Puts focus on the Materials document, adds a blank row, and allows you to create a new
material by defining its properties in the Properties Grid.

l Cut Parameter: Puts focus on the Cut Parameters document, adds a blank row, and allows you to cre-
ate a new cut parameter by defining its properties in the Properties Grid.

l New Milling: Puts focus on the Tools document and opens the ToolWizard where you can create a new
milling tool.

l New Hole Making: Puts focus on the Tools document and opens the ToolWizard where you can create
a newhole-making tool.

Single-click an item in a document to edit its parameters in the Properties Grid. Alternatively, double-
click any tool or holder to open the ToolWizard, or Holder Wizard where you can edit parameters. You
can also edit assemblies in the Assembly Tree. Edits youmake in the Assembly Tree update the para-
meters in the Properties Grid.

Exercise 3: Searching for a Library Component
In this exercise, you search for a tool library component using the Search window.

1. Select Search on the Home tab.

16
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The Search windowdisplays.

2. Select Tools on the Home tab.

In this exercise, you are searching for a specific tool.

3. Select items from the Search Item and Condition drop-down lists, and enter appropriate search criteria in
the Value field to further narrow (filter) your search. For this exercise, enter values as shown below:

As soon as you choose a Search Item, a new row in the datagrid appears, allowing you to search by more
than one Search Item. To remove a line of search criteria, select it and press [Delete].

4. Select Search to display your search results.

5. Your search results should be similar to the image below:

These results are automatically added to your Recent Search list, accessed by selecting Recent. To execute
the search through shortcut keys, press [Ctrl] + [Enter].

Mastercam Tool Manager Tutorial—1: Working with Tool Library Files (.TOOLDB)



To add an item to a database already open in ToolManager, drag the item from your Search window and
drop it into the appropriate tree node in the ToolManager'sDatabase Explorer. The item is added to the
appropriate document.

6. Select Favorite on the Home tab.

7. Enter FlutesMetricDiameter for the name of the search, and click Add. This saves the search as a favorite
for future reference.

8. The name of the saved Favorite appears in the Favorites folder:

9. You can also use the Default Searches, provided with the ToolManager, to open common database
searches.

10. Exit the Search window.

18
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CHAPTER 2
WORKING WITH COMPONENTS IN A TOOL LIBRARY

In this lesson, you learn to create and edit tool library components.

Goals

l Create and edit tools, holders, and assemblies

l Use the graphics display to edit assemblies

l Add and edit materials and cut parameters

Exercise 1: Creating a New Tool
In this exercise, you create a new tool.

1. If necessary, open the ToolManagerTutorial_XXX.tooldb file.

2. Select the Bull-Nosed Endmill tool type in the New Milling group.

The ToolWizard displays.

3. In the Define Tool Geometry page, change the following parameters:

l Overall length to 85.

l Cutting length to 30.

19



4. Ensure that your other parametersmatch those shown in the image below. The tool image updates as you
make changes.

5. ClickNext to work in the Finalize Properties page.

6. In the Finalize Properties page, make the following changes:

l Set Tool number to 1.

l Set Length offset to 21.

l Set Diameter offset to 41.

20
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7. Ensure that your other parametersmatch those shown in the image below.

8. Click Finish to save your changes. This adds the new tool to the open library and closes the ToolWizard.

Exercise 2: Creating a New Holder
For this exercise, you create a new tool holder.

1. Select Holder on the Home tab.

The Holder Wizard displays.

2. In the Define Holder Geometry page, change the following parameters:

l Set Upper Type to CAT.

l Set Upper Size to 30.

3. Press [Enter]. This displays and highlights the holder that matches your entered parameters.

Mastercam Tool Manager Tutorial—2: Working with Components in a Tool Library



4. Ensure that your parametersmatch those shown in the image below.

Note: If you need to add and define a new segment, select Add Segment and define the segment para-
meters in the database grid. To remove a segment, select the leftmost cell for that row and press the
[Delete] key.

5. SelectNext.

6. Enter TUTORIAL MAIN HOLDER in the Description field, and select Thru coolant to set the coolant option
to flow through the holder.

7. Select Finish to save your changes. This adds the newholder to the open library, and closes the Holder Wiz-
ard.

22
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Exercise 3: Editing Existing Tools and Holders
In this exercise, you edit a tool with the ToolWizard. Editing a holder is similar, so it is not covered. The only dif-
ference is, when you edit holders, you work in the Holder Wizard as described in the previous exercise.

Note: In addition to editing tools and holders using the wizards, you can also select a component in the document,
and edit its properties in the Properties Grid.

1. Open the Tools document and double-click tool number 463 (3. FLAT ENDMILL).

The ToolWizard displays.

2. In the Define Tool Geometry page, change the following parameters:

l Set Cutting diameter to 5.

l Set Overall length to 50.

l Set Cutting length to 25.

l Set Shoulder length to 30.

Note: If you see amessage in the graphics display similar to the one shown below, ignore it for this exercise.
As you complete entering the values, the error messages are replaced with the tool graphic because you
have resolved all geometric property conflicts.

Mastercam Tool Manager Tutorial—2: Working with Components in a Tool Library



3. Ensure your parametersmatch those shown in the image below:

4. SelectNext.

5. Set the following parameters:

l Set Tool number to 2.

l Set Length offset to 22.

l Set Diameter offset to 42.

l Enter FLAT ENDMILL - TUTORIAL inName.

6. Select Finish to save your changes.

Exercise 4: Creating and Editing Assemblies
Create assemblies using a drag-and-dropmethod, as described in the following procedure. Here you only add one
holder to the assembly, although you can addmultiple holders using the same drag-and-dropmethod.

1. Select Assemblyon the Home tab. This opens the Assembly Tree pod and the Assemblies document.

2. Select the Holders document.

24
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3. Drag and drop the holder C4E4-1000 from the Holders document into the Assembly Tree.

4. Drag and drop the tool 23. CBORE from the Tools document into the Assembly Tree.

5. View a graphical representation of your assembly in the graphics windowby clicking the top line of the
assembly.

The following steps showhow to change a tool in an assembly. This same process applies to any component type in
assemblies.

Mastercam Tool Manager Tutorial—2: Working with Components in a Tool Library



6. Select the 23. CBORE tool in the Assembly Tree and press the [Delete] key.

7. Drag and drop the tool 12.6 CBOREfrom the Tools document into the Assembly Tree.

As you add and remove assembly components, the name of the assembly changes.

26
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Editing Assemblies in the Graphics Window

Besides editing assemblies by changing settings in the Properties Grid, you can reposition the assembly (or its
extensions) along the center line of the tool in the graphics window.

1. In the Assembly document datagrid, select the assembly you worked on in the previous exercise.

2. In the graphics window, place your cursor over the holder, hold down the [Ctrl] key, and click the holder. The
assembly is highlighted and a dynamic ruler displays.

The ruler always displays absolute dimensions, whichmeans that the tool projection value is alwaysmeasured
from the tool tip to the face of the holder.

When you hover over the holder, press the [Ctrl] key to have the cursor indicate thismode. If the cursor
does not change, youmay need to click the holder to put focus in the graphics window.

3. Once the ruler displays, move your mouse back and forth along the center line of the tool to change the
length that the tool extends from the holder. You will see the dynamic ruler floating, and the tool projection
value in the text box changing with your mouse movement.

4. Click anywhere off the tool or holder in the graphics window to set the projection distance of the tool.

Whenworking with assemblies, you can change the Tool Projection value in the graphics window. The Tool Pro-
jection field in the Properties Grid updates as youmanipulate the assembly graphic. You can also use the Tool Pro-
jection field in the Properties Gridto change those values.

When the dynamic ruler is active, change the ruler increments by zooming in or out with your mouse wheel. This is
helpful if you want to be more or less precise in your Tool Projection value. The number of graduations are appro-
priate to the selected units specified in the Options dialog box.

With the ruler active, click and drag it to snap your Tool Projection value to the ruler's incremental distance lines.
The movement is only between the shoulder length and overall length values.

Exercise 5: Adding or Editing Materials
Workpiece materials are part of the TOOLDB database files. They display in the Materials document in ToolMan-
ager. Although you can edit some of the materials' properties in the Properties Grid, the Materials document is
primarily used for reference information whenworking with cut parameters.

Mastercam Tool Manager Tutorial—2: Working with Components in a Tool Library



Note: Since it isn't possible for a toolmanufacturer to test every possible material for every tool, the workpiece
materials specified in a tool library may not match the actualmaterial for a given job. Use the ISO group property to
find a suitable cut parameter setting as a starting point.

1. SelectMaterial on the Home tab to display the Materials document.

2. Select theMaterials document to view the materials grid.

3. Select the first row in the data grid and set the following parameters in the Properties grid:

l Enter Aluminum for Name.

l Set Hardness to 60.

l Set Hardness Units to Rockwell B Hardness.

l Set ISO Group Value toN - Aluminum, Copper, and Non-Metallic.

4. To edit the materials properties for that same material, change the following parameters:

l Enter Aluminum - 6061 for Name.

l Set Hardness to 95.

l Set Hardness Units to Brinell Hardness Scale.

Your changes are automatically saved to the database.

28
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Exercise 6: Adding and Editing Cut Parameters
Cut parameters are also part of the TOOLDB database files. They display in the Cut Parameters document, where
you can edit themas needed. These parameters are primarily used inMastercamwhen you import cutting speed
and feed per tooth data into an operation.

1. Select Cut Parameters on the Home tab to display the Cut Parameters document.

2. Select the Cut Parameter document to view the materials grid.

3. Select the first row in the Cut Parameters document and set the parameters in the Properties Grid:

l Enter Aluminum - 6061 forMaterial Name.

l Ensure thatMetric is checked.

l Enter Shouldering Aluminum with 16mm Endmill for Name.

l Set Operation Type to Shouldering.

l Set Feed Per Tooth to 0.075.

l Set Rough Axial Depth of Cut and Finish Axial Depth of Cut to 10.

l Set Rough Radial Depth of Cut and Finish Radial Depth of Cut to 8.

l Set Surface Speed to 90.

l SetMaximum Diameter to 18.

l SetMinimum Diameter to 16.

Mastercam Tool Manager Tutorial—2: Working with Components in a Tool Library



Notes:

l Some of the fields are automatically populated and non-editable because that information comes from the
material you choose.

l If you are creating a newdatabase or if the desired workpiece material does not exist, you need to create the
material before creating the cut parameters.

Exercise 7: Accessing Cut Parameters fromMastercam
In this exercise, you apply the cut parameters you created to aMastercam toolpath to update the surface speed
and feed per tooth values.

1. Start Mastercam2019.

2. Open the part file Dynamic_Mill_Rest, provided with this tutorial.

3. Select File, Save As, and save the part as Dynamic_Mill_Rest_XXX, replacing XXX are your initials.

4. Select Parameters under the second operation in the ToolpathsManager.

30
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5. Select the Tool page.

6. Right-click in the tool list and select Search for cut parameters.

The Search windowdisplays.

7. Select File, Open, and select the ToolManagerTutorial_XXX.tooldb file.

8. Ensure that the search criteria is as shown below:

9. Select Search. Your search results will display the cut parameter you created in the previous exercise.

Mastercam Tool Manager Tutorial—2: Working with Components in a Tool Library



10. Select the resulting cut parameter and click Accept.

This closes the Search window, and populates the Tool page feed per tooth (FPT) and cutting speed (CS) val-
ues with the parameter values you accepted.

11. ClickOK to accept the changes and close the dialog box.

Note: The Assembly Has Changed dialog boxmay display. This dialog box alerts you that the tool or holder
has beenmodified, and is referenced inmore than one operation in the current part file. If this dialog box dis-
plays, select Update assembly and all operations that use the assembly and clickOK.

12. Regenerate the toolpath.

13. Save the part file, and close Mastercam.

Exercise 8: Copying Components Between Tool Libraries
Use drag and drop to copy items fromone database to another. To do this, youmust have two or more sessions of
ToolManager open concurrently.

1. Start another session of ToolManager through the Windows’ Startmenu. You should still have the ToolMan-
agerTutorial_XXX.tooldb open in the current session of ToolManager.

2. Click the Open button and navigate to this guide’s install location.

3. Select the ToolManagerTutorial.tooldb file and clickOpen to load the database.

4. Position the two sessions of ToolManager side-by-side or one partly covering the other, resizing the windows
as necessary.

5. Open the Tools document in each ToolManager window.

6. In the ToolManagerTutorial_XXX.tooldb session of ToolManager, select tool number 1 (12 Bull-Nosed
Endmill).

32
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7. Drag and drop the 12 Bull-Nosed Endmill onto Cutting Tools in the ToolManagerTutorial.tooldb ses-
sion of ToolManager. Because the copied tool has the same tool number as an existing tool, it is renumbered
to the next available number.

You can copy database items under the following drag and drop conditions:

l Fromone database Assemblies, Holders, Tools, Materials, or Cut Parameters document to another
database's document of the same type.

l Fromany Assemblies, Holders, or Tools document in one database to the Assembly Tree of another to
build or copy new assemblies.

You can change also tool numbers by double-clicking the tool in the document and changing the tool number
in the ToolWizard, or you can highlight the tool in the document and change the tool number in the Prop-
erties Grid.

8. Close both sessions of the stand-alone ToolManager.

Mastercam Tool Manager Tutorial—2: Working with Components in a Tool Library
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CHAPTER 3
USING TOOLS AND HOLDERS IN TOOLPATHS

In this lesson, you learn to work inMastercam’s classicMill ToolManager using the stand-alone ToolManager’s integ-
rated functions.

Goal

l Create and edit tools and holders within the Toolpath Parameters Dialog.

Exercise 1: Creating a New Tool
1. Start Mastercam.

2. Open the part file Dynamic_Mill_Rest_XXX, from the previous lesson.

3. Click the Parameters icon for the first operation in the ToolpathsManager.
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4. In the Tool page of the DynamicMill dialog box, right-click in the tool list and choose Create new tool.

The ToolWizard displays.

5. In the Select Tool Type page, select Flat End Mill, and clickNext.

6. In the Define Tool Geometry page set the following tool parameters:

l Set Cutting diameter to 18.

l Set Overall length to 90.

l Set Cutting length to 60.

l Ensure that Shoulder length is set to 60.

l Ensure that Shoulder diameter is set to 18.

l Ensure that Shank diameter is set to 18.

7. Make sure your parameters in the Define Tool Geometry page match those shown in the following graphic.

8. ClickNext to work in the Finalize Properties page.

9. In the Finalize Properties page, make the following changes:

l Enter 18 Flat Endmill - Tutorial for Name.

l Enter New tool for tutorial for Description.

36
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10. Make sure your parameters in the Finalize Properties page match those shown in the graphic below.

11. Click Finish to save your changes. This adds the new tool to the part, closes the ToolWizard, and returns you
to the Tool page.

12. Do not close the 2D High Speed Toolpath - DynamicMill dialog box.

Exercise 2: Creating a New Holder
1. Select the Holder page.

2. Select Open library.

The Open dialog box displays.

3. Navigate to your ToolManagerTutorial_XXX file.

4. Select it, and clickOpen. The Holder page will display your current library.

5. SelectNew holder.

The Holder Wizard displays.

6. In the Define Holder Geometry page, set the following parameters:

a. Set Upper Type to CAT.

b. Set Upper Size to 30.

c. Set Lower Type to ID.

d. Set Lower Size to 18.
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7. Make sure your parameters in the Define Holder Geometry page match those shown in the image below.

8. ClickNext.

9. In the Finalize Properties page, set the following parameters:

l Enter New Holder for Tutorial for Description.

l Select Thru coolant, to set the coolant to flow through the holder.

10. Make sure your parameters in the Finalize Properties page match those shown in the following image.

11. Click Finish to save your changes. This adds the newholder to the part, closes the Holder Wizard, and returns
you to the Holder page.

You can see the newholder is added to the list, but not yet saved to the library. This is indicated with ames-
sage in the window and an asterisk next to the newholder name.

12. Click Save library and save your tool library.

13. ClickOK in the Dynamic Mill dialog box. Thismarks the toolpath dirty.

14. Click Regenerate all dirty operations to regenerate the toolpath.

15. Save the part file.

Exercise 3: Editing Tools and Holders
In this exercise, you edit a tool and holder inside of an operation inMastercam.

1. Open the part file, Dynamic_Mill_Rest_XXX from the previous exercise, if it is not already open.

2. Select Parameters under the second operation in the ToolpathsManager, and go to the Tool page.
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3. Right-click tool#476 and choose Edit tool.

The ToolWizard displays.

4. In the Define Tool Geometry page, change the Shank diameter to 22.

5. Click Finish to save your changes. This closes the ToolWizard, and returns you to the Tool page.

6. ClickOK in the Pocket dialog box.

7. Select Parameters under the first operation in the ToolpathsManager.

8. Select the Holder page.

9. Right-click on the CAT 30 - ID 18 holder and choose Edit Holder. Youmay need to scroll down the list to loc-
ate it.
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The Holder Wizard displays.

10. In the Define Holder Geometry page, clickNext to leave settings as is.

11. In the Finalize Properties page, change the Name to CAT 30 - ID 18 - Tutorial.

12. Click Finish to save your changes. This adds the edited holder to the part, closes the Holder Wizard, and
returns you to the Holder page.

13. Save your changes to the library as described in the previous exercise.

14. ClickOK in the 2D High Speed Toolpath - Dynamic Mill dialog box.

15. Save the part file.
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CHAPTER 4
RENDERING MASTERCAM TOOLS

Mastercamhas the ability to define a tool using parametric properties along with a customprofile that can be impor-
ted fromaCAD file or a level within your part file. Mastercamuses the parametric values within the toolpath cal-
culations for improved performance. Mastercamuses the optional customprofile, when provided, for stockmodel
generation and collision checking in Backplot, Verify, andMachine Simulation. Mastercam’s ToolWizard provides the
option of displaying both profiles for comparison.

Note: Note: This function is not available in the stand-alone version of ToolManager.

The ToolWizard renders the customprofile as a 3D shaded tool and overlays the parametric profile using a solid
line. You can toggle this behavior to render the parametric tool and overlay the customprofile.

Goals

l Understand howMastercam renders tool profiles

l Create a new tool froma profile

How Mastercam Renders Tool Profiles
When you use a tool profile to create a new tool, whether you import the profile froman external file or froma pro-
file stored in your part file, if you choose to create the tool based on the CustomTool type, Mastercam tries to
approximate its parameters.

Occasionally, Mastercam fails to populate the Custom Tool parameters accurately. The toolmay look correct in the
ToolWizard when rendered as an imported tool and will display as a correctly-defined tool in backplot and verify, but
Mastercamuses the tool parameters from the Define Tool Geometry page in the ToolWizard when creating
toolpaths, which do not alwaysmatch the true tool profile. This can result in unexpected toolpath behavior such as
gouging, leaving toomuch stock, or randomairlifts. Mastercam is using the toolpath compensation based on the
parametric values rather than the imported profile shape.

The example below shows an incorrectly defined tool froma profile stored on level 200 in the Custom_tool_Test-
ing part file included with this tutorial. You can see that the rendered tool that Mastercam created (shown on the
left) does not match the actual definition from the imported profile (shown on the right).
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Even though the rendered Imported Tool shown on the right looks correctly defined, Mastercamuses the
renderedMastercamTool shown on the left during toolpathing. The results of the cut are shown below, viewed
from the right-side view. Because Mastercam is compensating the toolpath to the MastercamTool, which is shaped
like a flat endmill and not the Imported Tool, the tool is not cutting to the surface of the part, but rather leaving a
gap. Mastercam is compensating the toolpath to the theoretical corner of the MastercamTool, even though it dis-
plays as the Imported Tool.

This can often be misdiagnosed as a toolpath problem. If you have a referenced profile and/or custom tool and are
seeing problems in the toolpath, check your tool definition andmake sure that the MastercamTool and Imported
Toolmatch.

View this by backplotting operations 1 and 2 of the Custom_Tool part file included with this tutorial.

To create custom tools based on profile geometry, it is almost always best to select a tool type that most closely
resembles the tool you are creating rather than basing the tool on the CustomTool type. By basing your custom
tool on a similar tool type, you can parametrically define the tool to match the MastercamTool uponwhich your
toolpaths are calculated.

Exercise 1: Creating New Tools from Profiles
In this exercise, you create a new tool based on a tool profile fromwithinMastercam. These tools are used in
toolpaths on the part supplied with this tutorial.

1. Start Mastercam2019.

2. Open the part file Custom_Tool, provided with this tutorial.

3. Right-click in the graphics window and choose Fit to fit the part to the screen. Your part should look similar to
the picture below.
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4. Select File, Save As, and save the part as Custom_Tool_XXX, replacing XXXwith your initials.

5. Select Tool Manager on theMill Toolpaths contextual tab.

You will create a custom tool similar to the 0.375 Bull-Nosed Endmill tool used in operation 4.

6. Right-click in the tool list window and select Create tool.

The ToolWizard displays.

7. Select the Bull endmill tool type.

The custom tool profile is created as a bull endmill.

8. SelectNext.
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9. Select Import and link to custom geometry from a level.

The Select Level dialog box displays.

10. Select level 200, and clickOK.

11. Toggle between viewing the custom tool by select Render Mastercam Tool and Render Imported Tool.
They do not match. The MastercamTool parameters need tomatch the Imported Tool profile.

12. On the Define Tool Geometry page, enter the following parameters:

l Set Cutting diameter to 0.375.

l Set Overall length to 2.5.

l Set Radius to 0.125.

l Set Shoulder length to 1.

l Set Shoulder diameter to 0.375.

l Set Shank diameter to 0.5
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13. Ensure that your parameters in the Define Tool Geometry page match those shown below:

Notes:

l When creating custom tools from imported profiles, Mastercampopulates the parametric fields with
estimated values. However, youmust edit these values to match the imported profile parameters. Usu-
ally these imported tool profile parameters are retrieved in one of the followingmethods:

l If the tool profile was created without importing it froma clearly-defined specification, you can
analyze the profile geometry inMastercam to obtain the values.

l If the tool profile was imported fromamanufacturer, you can find the values from their web site
or tooling catalog.

l If you have a tool but do not know the origin of that tool, you can obtain the parameters using a
tool setter to measure the tool values.

14. Toggle between viewing the custom tool as a renderedMastercamTool or a rendered Imported Tool. You
can see that the rendered shapesmatch, showing that the MastercamTool that is used to create the toolpath
has the same profile values as the Imported Tool.
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15. SelectNext and edit the parameters as shown below, renumbering the tool as needed.

16. Select Finish. Since you have changed the new tool with a number already assigned to a tool in the current lib-
rary, a warning will appear, as shown below:

17. ClickOK to add the similar tool. Tool libraries allowmultiple tools with the same number.

18. ClickOK in the ToolManager to accept your changes.
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19. To view a similar, correctly-defined tool, backplot the fourth operation, rotating the part to view the cor-
rected toolpaths. The tools now cut accurately and you can see that the newparametric tool definition
matches the tool profile used in Backplot, tracing the surface as expected.
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CONCLUSION
Congratulations! You have completed the Mastercam Tool Manager Tutorial! Now that you have mastered the skills
in this tutorial, explore Mastercam's other features and functions.

Youmay be interested in other tutorials that we offer. Mastercam tutorials are being constantly developed, and we
will addmore as we complete them. Visit our website, or select Help, Tutorials from the File tab.

Mastercam Resources
Enhance your Mastercamexperience by using the following resources:

l Mastercam Documentation—Mastercam installs a number of helpful documents for your version of software
in the Documentation folder of your Mastercam2019 installation.

l Mastercam Help—AccessMastercamHelp by selectingHelp, Contents fromMastercam's File tab or by press-
ing [Alt+H] on your keyboard.

l Mastercam Reseller—Your localMastercamReseller can help withmost questions about Mastercam.

l Technical Support—Our Technical Support department (+1 860-875-5006 or support@mastercam.com) is
openMonday through Friday from8:00 a.m. to 5:30 p.m. USA Eastern Standard Time.

l Mastercam Tutorials—We offer a series of tutorials to help registered users become familiar with basic
Mastercam features and functions. Visit our website, or select Help, Tutorials fromMastercam's File tab to
see the latest publications.

l Mastercam University—MastercamUniversity, an affordable online learning platform, gives you 24/7 access to
Mastercam trainingmaterials. Take advantage of more than 180 videos to master skills at your own pace and
help prepare for MastercamCertification. For more information onMastercamUniversity, please contact
your AuthorizedMastercamReseller, visit www.mastercamu.com, or email training@mastercam.com.

l Online Communities—You can find awealth of information at www.mastercam.com. For tech tips and the
latest Mastercamnews, follow us on Facebook (www.facebook.com/mastercam), Twitter
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam). Visit our YouTube channel to see
Mastercam in action (www.youtube.com/user/MastercamCadCam)! Registered users can search for inform-
ation or ask questions on the MastercamWeb forum, forum.mastercam.com, or use the knowledgebase at
kb.mastercam.com.

Contact Us

For questions about this or other Mastercamdocumentation, contact the Technical Documentation department by
email at techdocs@mastercam.com.
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